Smart Objects

ThinkDesign offers many unique capabilities to designers and engineers. Among them is the utility to save and
catalog objects for reuse what think3 calls "Smart Objects". Smart Objects can be profiles, operations referenc-
ing the profiles or a combination of the two. This task entails creating a directory of Smart Objects and then de-
ploying them to create a gear case cover. In this task, we shall learn how to create each of the three types of
Smart Objects, how to create a Directory that they will go into, how to insert the components into the Directory,
how to use the Smart Objects in the creation process of other parts, and finally, how to create Smart Object Fam-
ilies.
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1. Step 1: Getting "Smart" with Profiles

In this first step, we shall create a profile. We shall then make it into a Smart Object profile, create a directory
for it, enter the profile into the directory and perform some redefining operations on it.
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Let's set the Work Plane options:

* Right click in the graphics area, and select Options/Properties.
*  Click the System Options tab.

*  Click the Reference Systems from tree and select Appearance.
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Click the OK button.

e Click on Insert > Profile > 2D to insert a Profile.

» Insert a Rectangle in the graphics area with dimensions of 300 by 250.

* Click the Rectangle icon, and in the Selection list, click the Center + Sizes option.

¢ Click the X size and set it to 300 as X Size300.

¢ Click the Y size and set it to 250 as Y Size250.

W gize 250 mm

Angle O deg

X =ize 300 mm

* To place the Rectangle, snap to the Work Plane Origin.

Place a fillet of 30 mm at each of the corners.

*  Click the Insert Fillet icon, then click on one of the corner edges to highlight it.

* Type in 30 and click on the other edge that forms the corner with Radius30

* Click on all the successive corners to place a fillet of Radius30 on all corners.
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N /

Radius 30 mm l%ﬁf;

Hit[Esclto end the command.

Convert the geometry into a profile.

* Box select all the geometry.

e Click Profile to convert all the curves into a Profile.
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Add some Smart Dimension specifications:

* Add a Smart Dimension between the left edge and the center of the bottom left fillet in X and the bottom
edge and the center of the bottom left fillet in Y. Repeat for the right edge to the upper right fillet center in X
and the top edge to the upper right fillet center in Y.

* Add a Smart Dimension between the left edge of the rectangle and the right edge, then one from the bottom
edge to the top edge of the rectangle.
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Place some of the following constraints on the profile, that help in defining it.

¢ Set a Ground Constraint at the arc center of the bottom left fillet.

* Set a Coincident Constraint with the Parameter option set to Y Point, between the arc center of the top
right fillet and the arc center of the top left fillet, and a similar Y Point constraint between the arc centers of
the bottom right, and bottom left, fillets.

» Set the Parameter option to X Point and apply the constraint between the arc centers of the bottom left, and
top left, fillets and that same constraint between the bottom right, and top right, fillet arc centers.
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Add a Smart Dimension to each of the four corner fillets.

e Start the Smart Dimension command.
» Pick on the fillet edge.

* Click to place the dimension.
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Place both a horizontal and vertical Orientation Constraint to locate the profile in space.

* Select the Orientation Constraint in the parameter area, using the Horizontal option, and clicking on the
bottom horizontal edge.

» Select the parameter option, Vertical and click on the left vertical edge.
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What we're going to do now is to create a Reference Line from the center of the bottom left fillet arc center to
the center of the top right fillet arc center.

Note:

By creating this reference line we can snap the location anchor for our smart object, to its center. What this es-
sentially does is that it helps us to specify the center of the profile as the locating point, while placing it in the
graphic area.

o Start the Two-point Line command, with the following options set: Type: Limited, Sequence: Single; and
Option: Polar.

» For the first point, click the center of the lower left fillet arc, and for the second point, click the center of the
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upper right fillet arc.

context menu.

Hit (Escto end the command. Right click on the line, just drawn and select Make Reference option from the
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Perform a check of the profile to see how it's currently constrained.

- &2 check Profile | )€
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Switch to Model . We should see the Profile entry in the history tree, signifying were ready to define a Smart

Object profile.
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Let's enable the Smart Object Toolbar.

-
!
1
]

» Right click on the Parameter area and select the Smart Object option. This will display the Smart Objects
toolbar.
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Convert the profile just created into a Smart Object.

* Click Define Smart Object.

* Enter Rectangle Profile for the name.

Define Smart Object E

F‘mpertiesl Dptions] F‘arameters] Fleferenc:es] Configurations]

General
Mame: |F!ectang|e Prafile Drescription: F

Selection

Elements: Select... 1]

oK | Cancel | |

» Right click on the Profile entry in the History tree, and click the Add option.
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Move the Anchor point to a more convenient location at the center of the profile.

*  On the Define Smart Object (dialog) window, for the Anchor point, click the Select... option.

* Use Mid Point Snap and click on the reference line to locate the Anchor point at the profile's center.

Define Smart Object

Plopertiesl Dptions] Parameters] Heferences] Eonfigurations]

General
Mame;: Fectangle Prafile Description: 7

Selection

Elements: Select... 1
Ancher poink: Select... I

| Cancel |

» Hit the OK button after you define the Smart Object profile.

It's now time to Save Smart Object into a directory that we can access in the future.

* Click Save Smart Object.

» Set your directory to be SO_Libraries.

Note:

The SO Libraries directory is normally found in the following path:  C:\Program
files\think3\2006.2\thinkdesign\SO_Libraries. If, for any reason, it isn't found there, you should contact your
system administrator, or do a file search. This is the directory whose subdirectory entries are the actual tabbed
entries in ThinkDesign.

Save Smart Object

Save in: |@ S0_Libraries ﬂ = £k E-
I5) AdvSamples ) MetalMach
|C5) Casting |5) Plasstic
) ExctProfiles [2) sheetmet
[C2) Exctrusion () ThrHales
|C2) GerProfiles
|2) GenShapes
[ Holes
) Keyedeyhouse

File name: | j
| Cancel

Save as type: |Smart Objects [*.=f]

* Click the icon folder to Add a new folder whose name will be the tabbed name for your directory in
ThinkDesign.
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* For the Name, type in MySmartObjects.

Save Smart Object

Save in: |B 50_Libraries j (] £k E-
1) AdvSamples |5 MetalMach
|C5) Casting () MySmartObiects
) ExtProfiles |5 Plastic
|2 Exctrusion |5 sheetmet
|5) GenPrafiles =) ThrHales
|5) Genshapes
) Holes
) Keyakeyhouse
T =
Save as type: | Smart Dbjects [*] ~| Cancel

Enter the Smart Object in that directory.

* Double click on the MySmartObjects directory to open it.

* For the Name, enter Rect_prof.
Save Smart Object
Save in: |l’f} tySmartDbjects j & &= Ef-

ﬂ Many Holes, sf

File: mamme: |Hect_F'er j
Save as ype: | Smart Objects %] | Cancel

¢ Click the Save button.

* As the system is prompting for the selection of the entry for the Smart Object, click on any part of the pro-
file.

* Click Yes to the prompt, Selection OK ?

Finally, let's verify that the entry has been placed in the directory correctly.

* Click Smart Object Library.

*  Click the tab MySmartOjects.
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14> | 6 Model [€> 20 Profile | [l 3D Profile |

Rect_Prof

With your Smart Object profile now shown in the MySmartObjects directory, it's time to test out how it works:

* Left click and drag the Rect prof into the graphics area.

e At a suitable location, release the mouse button.

4> |52 Model [€> 2D Profile | L 3D Profils

Rect_Praf

*  Click the OK icon to complete the command.

Well, that's okay. But wouldn't it be even better if we can add some variables to it that enable us to modify the
shape, once added into our design session. So, let's Redesign the Smart Object to reference parameters.

* In the History Tree Right click on SProf Rectangle Profile.

* Click on the Redesign option.

10
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Click the Parameters tab on the Define Smart Object (dialog) window and review the entry values:

Define Smart Object

Properties] Optiong Parametersl Heferences] Eonfigurations]
Meszage | MName | Expression| Walue |E:n:|:|oset:||A
1 Profile dimersion 300 mm |~
2 Profile dimenszion 250 mm |~
3 Prafile dimension M mm | hd
< b3
r [~ Show only exposed

| Cancel |

Edit the table to contain the values specified:

* For the entry having a value of 300 (i.e., the Width), type in Width for the Name entry.

Define Smart Object

Properties] Optiong Parametersl Heferences] Eonfigurations]

Meszage Mame | Expression| “alue |Exposed| #

1 o (O "/ icth
2 Profile dimenszion 250 mm |~
3 |Profile dimension M mm | hd
< >
r [~ Show only exposed
Rebuid | Cancel |

* For the entry having a value of 250, enter the Name as Height and for its Expression, enter Width*(5/6).
* Enter the Name the first 30 mm Profile Dimension as Distl and assign the Expression for it to be Width*0.1.

* Set all the other 30 mm Profile Dimensions with an Expression set to Dist1, assigning a Name for each entry
sequentially: Distl, Dist2, etc.
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Note:

If you enter expressions making a Profile dimension dependent on another parameter the Exposed box is grayed
out. Only Profile dimensions that have no dependencies can be exposed for change later.

Define Smart Object

Properties] Options Parametersl Heferences] Eonfigurations]

Meszage | MName | Expression| Walue | Exposed| ~
g Profile dimension | Dist? Drist1 3mm |7
Profile dimenzion | Distd Dt
v
< >
r [~ Show only exposed

Rebuid | Cancel |

*  Click the Rebuild button to update the Smart Object definition.

We now have a redesigned smart object that incorporates our modifications. Note that the only dimension
shown is the one marked as Exposed in our Parameter table. It's time now to test it out.

¢ Double click on the dimensional value.

* In the box that appears, enter a value of 100 instead of the 300.

E xpreszion Walue

v X0 || [100 mm

* Click Rebuild Model to see the change.

Time now to save our changes to the Smart Object profile.

* Click Save Smart Object.
* Click on Rect_prof.sf.

¢ Click the Save button.

12
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» Say Yes for the replacement.

Save in: |@ MySmartOhjects ﬂ =5 B

Rect_Prof

File name: |F|ec:t_F'rof Save

Save as type: |Smart Objects [.f) j Cancel
Internet...

You will then be prompted to Select a Smart Object for the directory.

* Click on the edge of the profile to select it.
* Answer "Yes " to the question, "Selection OK?"

* Right click in the directory area and Select Refresh to get the new icon.

P [ T2 T |6 Model

x|

py| )

kary Holes Rect_Prof

There are other options you can set for a Smart Object to make it even "Smarter", and we will cover them in
subsequent projects. Question now is, can we make a Smart Object out of operations such as extrude, etc? Well
the question being asked, we will pat ourselves on the back for what we have just completed and move on into
the next project that gives us our answer.

2. Step 2: Using Smart Objects for Operations

In our last project, we learned how to make a Smart Object out of a profile. Our goal now is to capture several
operations that will create a Wall extrusion and a Lip_extrusion respectively, saving them as Smart Objects as
we go. We shall start with the Wall_extrusion first.

§
|2
g [
b o
( > R E]
| T
o
— i
Lip_extrugion =z
s
i B
=
o
5o
o
{23
= |
e =
L
=
1 g
Rect_prof g =
T |3
i &
o
a
o
o
2
sy P
1]
N =2
wiall_extrusion (a0
o =
E4
L

13



Smart Objects

For our first step, we'll reference a profile created using our Smart Object Profile.

* Delete everything in the graphics area.

% - @ 5_"_’ £ Model

x|

Pyl -

Mary Haoles Rect_Praf

Create a reference profile in the graphics area.

* Drag/drop a Rect_prof into the graphics area, somewhere in the vicinity of the Work plane.

*  Click OK.

* Double click the dimension and change to 300.

¢ Click the Rebuild Model icon.

Edit Driving Dimension

Expreszion Walue

v X [ | |33Dmm

Time now to add the extrusion.

e Start the Linear Solid command.

14
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* Click on any part of the geometry to highlight the profile.

» For the Depth enter a -100. Depth-100.

Note:

The values in minidialogs typically show positive values. Thus even though you enter a minus value, as soon as
you move out of the box, it will change to positive value, but the handle will change accordingly to reflect the
correct direction.

= @LinearSolid X v T
@ Profile

+- Mare Options

* Click More Options.

* Change the Thickness value to -5. Thickness-5
= g Linear solid [ €] W) [ 1
& Profile
=l More Options

Direction Mormal - ’_‘;_’:’_:

Extenzion Single dep‘th -

*  Click OK.

Well, we have a part made via a sweep of a profile, but the goal is to separate the Linear Solid from the profile
so that we can apply it to any profile. That's what we shall do as we create the Smart Object.

* Click Define Smart Object.

15
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* For the Name, enter Wall Extrusion.
*  Click the Description button.

* For the Description, type in: This adds a 5 mm thick wall that's 100 mm in the negative Z direction from the
profile. The thickness is added to the interior of the profile.

o)

five
added ko the

Properties l Dptions] Par. (04 | Cancel |

General
Name: |\N’all Estrusian Description:

Selection

Elements: Select... 1]

oK | Cancel |

» Hit the OK button to end the Description.

Time to specify what will be part of the Smart Object.

* In the History tree right click on the Linear Sweep entry.

* Select the Add option.
= % Modelt ‘
=@ solid (11)
- @
- & SPraf Ry
%{> ZD P Search

Search this Mame

Expand Al

Info 4

I —

* In the Define Smart Object (dialog) window, hit the OK button to end the command.

Before we get into the trouble of storing this smartobject with possible errors, let's test it and see if it works
properly.

* Drag/drop another profile into the graphics area from the MySmartObjects directory.

» In the History Tree, right click on the SObj Wall Extrusion entry and Select the Insert option. (Optionally,
click Insert Smart Object )
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- % Modelt
=@ solid (11)
(s g SON
+ }a Line;

Expand Al
44 Rall Back Here

y Redefine Feature
?‘ Delete Feature
Assign Yariable/Feature

Rename

Search
Seatch this Mame

Info 4

Save As Eg

Break
Create Srart Object Farnily
Redesign...

* In the Selection List area, note that the item being prompted for is the profile, so click on any geometry be-

longing to the profile.
= B Insert Smart Okject | €]
(5]

* Click OK to end the command.

As you can see, the command worked like a jewel, so now it's time to Save Smart Object this for future refer-
ence.

* Click Save Smart Object.

» Select the MySmartObjects directory to write to.

* Enter Wall extrusion as the name.
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Smart Objects

Save 3mart Object
Save i |l'f) MySmartObjects ﬂ = Bl

ﬂ Many Holes, sf
ﬂ Rect_Prof,sf

File: name: |Wa||_extrusi0rl ﬂ
Save as lype: |SmartDbiects [*5f) j m

*  Click the Save button.
* The system now prompts you to Select a Smart Object. Pick on the part just created.
* Respond Yes to the query, Selection OK?.

* Right click inside the library directory, MySmartObjects, and Select Refresh to update its contents.

/h
FIZIR]=] @ s

el -

M any Holes Rect_Prof  Wall_extrusion

Now it's time to create the Lip extrusion. As we already have a profile defined, we shall just add a Lip extrusion
to the larger of the two parts in our graphics area.

+ Start the Linear Protrusion command.
* Close the Fillet/Chamfer dialog option, we won't be adding any to this feature.

* The Selection List highlights that the system is looking for a profile. The profile is the same one that you ref-
erenced to create the Wall extrusion, move the cursor over the profile until it highlights.

= @ Linear Pratrusion LX]
@ Profile
=l Extension Depth -
= More Options
Direction Mormal -
———

[ FilletiCharmfer
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Smart Objects

* For the Profile click on the dimension of the profile to select all of it.
* Click on the top face of the the existing part to orient the lip.

» Finally, set the Thickness to be -40 Thickness-40 and the Depth to be -5 Depth-5 so that the lip protrudes
outward from the side walls and into the part from the top surface.

= iﬁLinear Pratrusion LXJ M L_!J
& Profile

I=l- Extension Depth -

o Face

= More Options 75—
ra

Direction Marmal = e
i i

[®- Filet/Chamfer |

¢ Click OK to end the command.

Now let's make this into a Smart Object, called Lip_extrusion.

* Click Define Smart Object.
* For the Name enter Lip Extrusion.

*  Click the Description button and type in: Creates a Lip extrusion that's 40 mm wide and 5 mm deep mea-
sured from the face it's located on.

» Hit the OK button to exit the Description box.

Description

0 m wide and 5 mm desp

d on.

Define Smart 0

Propertlesl Opti oK Cancel |
— General

Mamme: ILip Estrusion Description: |
— Selection

Elements: I Select... ID

ak. | Cancel I Apply |

* In the History Tree, right click on the most recently created (top of the list) Linear Protrusion and select
Add.
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Smart Objects

E% Modell

Expand all

Linear Sweep (1 Search

Search this Mame

Define Smart Object

Info

Properties | Dptionsl Para

— General |

3

Name: ILip Extruzion Description:. |

— Selection

Elements: I Select... IU

Ok, | Cancel I Apply |

Make sure that the Anchor is in a usable position.

e Review the location of the anchor.

* Verify that it is located on the profile that the Smart Object is based on.

¢ Hit the OK button to end the command.

Time to Save Smart Object.

* Click Save Smart Object.
» Set the directory to MySmartObjects.

* For the File name, type in lip_extrusion.

Save Smart Object

Save in: I&) MySmartObjects j - rj( ,

E Many Holes, sf
E Rect_Prof.sf
E Wall_extrusion.sfF

File: niamme: Ilip_extrusiorl j &I
Save as type: |SmartDbiects [*.%f) LI ﬂl
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Smart Objects

*  Click the Save button.
* Click on any part of the lip_extrusion geometry to identify it for the catalog.
* Answer Yes to the query Selection OK?.

* Right click in MySmartObjects and select Refresh.
VAN D) Model [ & 2D

&l 1] O

lip_extrusion  Many Holes Fect_Prof  'wall_extrusion

As usual, it's time to test out if it works by dragging and dropping this new lip_extrusion Smart Object onto the
other part.

* Drag/drop the lip_extrusion onto the top face of the smaller part.

* Review the Selection List and note that there aren't any profiles asked for.

Note:

If no Profile is specified, then there is no Profile for for reference for applying the lip_extrusion.

Orientation Default -

Direction Default

¢ Hit the Cancel button.

Time to repair our lip_extrusion Smart Object so that it seeks a profile.

* In the History Tree, right click on the SObj Lip Extrusion entry.

* Select the Redesign option. (Optionally, click Redesign Smart Object )
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Smart Objects

= % Modelt
=@ Solid (17)
a8 SCObj Lip Extl

+-EW SObj Wi Expand Al
+ )@ Lingar S
=@ Solid{11)
+- ¥ 50bj W P Redefine Feature
g Linear 5w B Delete Feature
Assign Yariable/Feature

44 Rol Back Here

Rename

Search
Search this Mame

Info 4

Insert

Save As

Break

Create Smart Object Family

* Review the History Tree and see that the underlying profile for the lip_extrusion has a lightning bolt by it,
signifying that it is part of the Smart Object definition.

» Right click on the profile and select to Remove it from the definition.

- Cﬁ Modell
=@ solid (17)
=&Y 50bj Lip Extrusion (22)
= 6':(] Linear Protrusion
“<<§> P Cemilo £4E%
+ &3 S0bj wal Exl Search
+ )ﬁ Linear Sweep 1
=@ solid (11 nfo »
+- 0 S0bj Wal Exl

1 @ Linest Swesp W—

Search this Mame

* In the Define Smart Object (dialog) window, click the Rebuild button.

Save Smart Object the new version of the Lip_extrusion.

* In the History Tree, click on SObj Lip_extrusion to select it.
* Click Save Smart Object.
» Set the directory as MySmartObjects

¢ Use the same name for the file.

Save Smart Object

Save in: |l‘f) MuSmartObjects j r:j( ,

4 lip_s .sf
ﬂ Many Holes, sF
ﬂ Rect_Prof sf
ﬂ Wall_extrusion.sf

File name: |Iip_extrusi0n. sf ﬂ
o e |

Save as type: |Smart Objects [*.sf]
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Smart Objects

e Click Save and click Yes to overwrite the old version.

* Click on the lip_extrusion geometry in the graphics area to select it in response to the system prompt, Select
Smart Object.

* Respond Yes to the query, Selection OK?

* Right click within the Smart Object catalog and select Refresh to get the updated lip_extrusion.

|_J,_Jljlj Frl Model

D) | Q

lip_extrusion  Many Holes Rect_Prof  Wwall_extrusion

Let's retest the lip_extrusion.

* Drag/drop the Lip_extrusion from the catalog onto the top face of the small part.

@le:] 11O

lip_extruzion  Many Holes Rect_Prof  Wall_extrusion

* As we are prompted this time for the missing Profile, click on the profile that is on the top of this face.
* Click OK to end the command.
Much better! Another validation of the power of Smart Objects!

(Optional) At this point, you may want to drag several profiles into the graphics area, modify their respective di-
mensions and apply the Wall extrusion and lip_extrusion operations to see how they all work together.

3. Step 3: Creating More Complex Smart Objects

The objective of this task is to create two more Smart Object profiles. These are more complex in nature, and we
will enter them into our catalog for future reference when we build the gear case top cover and base.

* To start with, Delete everything from the graphics area.

*  Close the Smart Object directory.

@il 10

lip_extruzion  Many Holes Rect_Prof  ‘Wall_extrusion

Let's start creating the geometry for the slot-shaped profile.
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Smart Objects

«  Click [F&}to orient the Work Plane for 2D geometry input.
* Click to activate Profile.

* Create a Center Circle

* Locate the circle by snapping to Work Plane Origin.

¢ Make the radius 300. Radius300

R300 2 €

Add a second circle.

¢ Set the Radius to 200. Radius200

» Locate the center for this circle to the right of the larger circle just created.

b

* Click to place the circle there.
«  Hit Escto end the command.

Add a Two-point Line that's tangent to both the circles at the top as shown in the image below.

* Click Two-point Line, Type: Limited, Sequence: Single.

* For the tangent point on the large circle, choose Tangent Snap and click on the top side of the circle.
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Smart Objects

* For the tangent point on the small circle, choose Tangent Snap and click on the top side of it.

T

e LEnith 4125534 mm

-

Add a Two-point Line that's tangent both the circles at the bottom.

* Repeat the instructions used for the top tangent line.

hid

Lencth 412.8534 mm

=
Nihgiraribs

«  Hit[escto end the command.

Remove the extraneous geometry in the interior of the profile.

* Use Smart Delete to delete the unneeded geometry.

« Hit[Escjto end the command.

Add constraints to the geometry.
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Smart Objects

* Select Ground Constraint and pick the center of the large circle.

¢ Set a Coincident Constraint for the Y Point between the center of the small circle and the center of the
large circle to align them horizontally.

Ta
FPal
Ta
PolC
FH0 G [750]
Ca
Pal
Ta
Fal
Ta

Insert a horizontal Smart Dimension between the center of the large circle and the center of the small circle.
= [ Smart Dimension | 3] €4
(@ Ertity or Paints

Orientation Automatic - o 43

1
Type Snap point - ‘ % %easure 420426 mm |
[+ Ditnension Format -

[+ Entity Properties
[+ More Options

Fel:

Perform a Check Profile of the profile to verify the constraints.

¢ Click Check Profile.

26


http://thinkcare.think3.com/thinkcare/help2006/english/sketcher/FWfile/T_FW_sk_09.htm
http://thinkcare.think3.com/thinkcare/help2006/english/sketcher/FWfile/T_FW_sk_09.htm
http://thinkcare.think3.com/thinkcare/help2006/english/sketcher/FWfile/T_FW_sk_08.htm
http://thinkcare.think3.com/thinkcare/help2006/english/sketcher/FWfile/T_FW_sk_08.htm
http://thinkcare.think3.com/thinkcare/help2006/english/dimensio/dm_15/FWfile/T_FW_dm_15.htm
http://thinkcare.think3.com/thinkcare/help2006/english/dimensio/dm_15/FWfile/T_FW_dm_15.htm
http://thinkcare.think3.com/thinkcare/help2006/english/sketcher/FWfile/T_FW_sk_27.htm
http://thinkcare.think3.com/thinkcare/help2006/english/sketcher/FWfile/T_FW_sk_27.htm
http://thinkcare.think3.com/thinkcare/help2006/english/sketcher/FWfile/T_FW_sk_27.htm
http://thinkcare.think3.com/thinkcare/help2006/english/sketcher/FWfile/T_FW_sk_27.htm

Smart Objects

= 2 check Profie | 3¢

Right Mumber of Constraints
Mo. of constraints: 13 (10 Logical, 3 Dimensional, 0 Dangling ext. ref.)
Mo, of entities: 4
=k More Options
el ]
welldefined:: 4 Ertities, 10 Snap poirts 1l
(R

Uniclerdefined: Mane <
-~
Owverdefined: Mone

P4
Mot Consistent: Mone

Feal:

Create Parameter names and expressions for the dimensions.

* Double click on the large radius dimension and for the Expression, enter LargeRad

* Click Twice on Rebuild Model to apply the Expression.
Ta

e

Edit Driving Dimension

Expression
|LargeFI ad

Walue
|3nn mm

v X1

* Double click on the small radius dimension and for the Expression, enter LargeRad*(2/3), then double click
on Rebuild Model to apply.

* Double click on the horizontal dimension and for the Expression, enter (LargeRad*(5/3))-50, then double
click on Rebuild Model yet again, to apply.

¢ Now double click to Switch to Model.
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Smart Objects

{LargeRad+ (520 -00

Now that we have a standalone profile, let's make it into a Smart Object profile.

* Click Define Smart Object.
* For the Name, enter Gearcase Slot Shape.

*  Click Description, and enter Drag and drop a profile that defines the outer shape of a slot-profiled gear case
cover., then click OK.

De : art Obje B

Ploperties] Dptions] Parameters] Heferences] Eonfigurations]

General
M ame: |Gearcase Slot Shape Description: 7
Selection
Elements: Select... 1]
Description |£|
— | |Drag and drop a profile that defines the outer shape of &
slot-profiled gear case cover| J
ak | Cancel |

Select the elements to include for the Smart Object Definition.

* In the History Tree, right click on the Profile entry, and select to Add the entry into the definition of the
Smart Object.

Review the various tabbed options of the Define Smart Object (dialog) window.

* Click on the Parameters tab of the Define Smart Object (dialog) window.

* As the LargeRad is the only independent value, and can thus be edited, it should be marked as Exposed. If
for some reason, it is not, please do so.
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Smart Objects

Define Smart Object

Properties] Options Parameters] Fleferences] Eonfigurations]

Meszage | Mame | E xpreszion | Walue | Exposed| -
1 Profile dimension  |LargeRa 300 mm | [

2 Profile dimension LargeRad(2 200 mm |~

3 Prafile dimension [LargeRad™[ | 450 mm |~ A
< ¥

- [~ Show only exposed

0K | Cancel | Apply

e Click the References Tab to continue.

* References lists the Prompt(s) that will be used when employing the Smart Object. You can accept them, or
type in a new Message prompt if you want.

Define Smart Object

Properties] Dptions] Parameters Heferencesl Eonfigurations]

Meszage | Tupe ~
1 Select an anchor point (20 Abzolute anchor

QK | Cancel | Apply

*  Click the Configurations tab.

» Configurations lists entries that are accessible from a pull down menu when you are using the Smart Object.
Add a second line below the Default line for a Special that has a value for the exposed dimension of the pro-
file of 400.

Define Smart Object

Properties] Dptions] Parameters] References Eonfigurationsl

Conf. name: | Profile |
1 Default 300 ram

Clear Conf. | Clear Table |

Ok | Cancel | Apply |

* As we have finished specifying the definition for the Smart Object, click the OK button to finish the com-
mand sequence.

Well, we have defined the Smart Object profile, but we need to Save Smart Object for use.

* Click Save Smart Object.

* Set the directory to the MySmartObjects directory, and enter Gearcase slot shape for the Name, then pick
the geometry to set up a picture in the directory.

* View the directory by clicking Smart Object Library and selecting the MySmartObjects tab to open it.
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Smart Objects

O @ | 1 Q

Gearcaze_zl.. lip_extruzion  Many Holes Rect_Prof  “Wall_extrusion

Let's run a quick test to see the results of our efforts.

* Drag/drop the Gearcase slot_shape into the graphics area.
* Click on the Configuration: option.
* Select the Special option.

= B insert Smart Okject (€] WA 11

= Anchar

@ Foirt

Criertation Default -
Direction Default -

Showe parameters: Mone -

Configuration: Default -

* Click OK to complete the command sequence

Finish the test by adding a Wall_extrusion and a Lip_extrusion to the profile just created.

* Drag/drop a Wall_extrusion onto the profile, then click OK.

* Drag/drop a Lip_extrusion onto the profile, specifying a Face, then click OK.

Suddenly, you have the power to create two different gear case frameworks of any size.
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Smart Objects

4. Step 4: Creating combination Smart Objects

Up to this point, we have focused on creating either Profile or Operation oriented Smart Objects. In this task, we
shall create a Combination Smart Object that will have both a profile and an operation defined within it. We are
going to design a Boss that has to fit around the external walls of our parts and rest on the adjoining lip features.
The boss features will provide reinforcement for the bolts used to clamp the cover and base of the gear case to-
gether.

* Review some of the parts you created at the end of the last step.

* Note the varied shape of the geometry that surrounds the transition edges between one wall surface and an-
other.

Our goal is to design a boss feature that will, in all cases, conform to the wall shapes that it rests against and is
able to be positioned on the intersection points shown as well as any other locations located around the periph-
ery of the walls of any part we might create.

First, we shall Hide Entities all the parts you have created as they will be used later to test our boss on. Then we
shall design a profile that will meet our requirements.
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Smart Objects

* Use the Hide Entities command to clear the graphics area of parts.
» Start Profile.

+  Verify that the work plane is On, and hit [Fé}to position it correctly for 2D profile input. If the work plane
icon indicates that it is linked to geometry, right click on it and select the Unlink option.

* Click to add a Rectangle, and select the CentSizes option. Enter X size25 and Y size32.5, locating the cen-
ter of the rectangle at the work plane origin.

Note:

When you type in a value and you are currently in Profile Mode, you will get a parallel line exactly offset later-
ally the amount you specified from the reference geometry. Additionally, the system will assign the value en-
tered as a Smart Dimension, thus helping you constrain the geometry as you go along.

Ho
Ve .

o

Create a Three-Point Circle bounded by the rectangle just created as shown below.

¢ Click to add a Three-Point Circle.

* Use Tangent Snap command three times to locate the circle's three points on the lines that bound it, as
shown.
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Smart Objects

[+ 3-Point Circle | )€
@ Points

Mode Circle -

O centerlines

e
HO

Clean up the extraneous geometry of the boss profile.

¢ Smart Delete the lines that define the outside corners of the boss.

* Smart Delete the internal arc within the profile of the boss.

Ho

Ve Ve

Ta Ta Pal

As the top of the profile is to be buried into the wall, we need to modify that part of the profile for the Smart Ob-
ject Anchor. The Anchor has to lie on the profile. Make the following modifications to allow this to happen.

e Add a Parallel Line, Type: Copy Length and Sequence: Single. The reference line is the topmost horizontal
line.

* As you drag the copied line down relative to its reference line, stop at some point and enter 2.5 to assign the
location.
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Smart Objects

£ ParalelLine | €]
@ Point

Type Copy length ~

Sequence Single
O Symmetric O

O Half Plane ‘ T
b Distance[2§ |
Ve Ve
Ta Tats o

* Add the two angled lines, created through Two-point Line as shown.

* Use Smart Delete to clean up the geometry.

Ho

§%POC

Ve \/e
Ia Ia SoC

Time to finish the profile, then unhide the parts so that we can add the geometry made by this profile to some-
thing that's existing.

e Click to Switch to Model.

*  Click to Unhide Entities all the parts.
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Smart Objects

In this next step, as we're just creating the extrusion portion of our Smart Object, we can place the Work Plane
on any of the side face of the existing part, so that we can define the extrude operation. Once we have captured
the operation as part of the Smart Object definition, we can Delete that feature, as we can then drag/drop the
Smart Object to locations that we specify.

* First, use Edit®*Work Plane™®Set on Faceand pick a side face (for ease of definition, use a flat side face)
to place the Work Plane on.

+  Use Modify®Profile®Move/Copy to Current Work Planeoption.

Create a solid by creating a Linear Protrusion from the profile.
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¢ Click Linear Protrusion.

* Close the Fillet/Chamfer dialog box.

» Select the profile and the face it's positioned on, leaving the Depth set to 50. Depth50
[El iﬁ‘l:‘il'lhear Protrusion w M L.!J

2 Pruﬁlz\\

=) Extenzion Depth «

e Click OK to end the command.

Well, we have got the boss we need--sort of. We still need to add a hole that will pass through the boss and the
wall of the underlying part. Let's add that to our definition of what will eventually become our boss.

* Click Hole
* Click on the top face of the boss.

» Right click on the Point and select to Reset it's definition, using the Center Point of the curved boss side just
formed.

B Hole ( 1
2 Face b
(= Type Point - B

@ Foirt 1
[ For screw
- Hale type: | Simple A4
Extension Thru (D
® Mare Optid e

~
i
-

LS

iameter 10 mm

¢ Set the Diameter for the hole to be 10. Diameter10
» Set the Extrusion option to Thru Next.
¢ Click OK to end the command.

Time now, to create the Define Smart Object for the boss.

*  Click the Define Smart Object.
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Smart Objects

* For the Name, type in Boss.
* Right click over the Linear Protrusion entry in the history tree and select the Add option.

* Right click over the Thru-Next Hole entry, and select Add.

Define Smart Object

Plopertiesl Dptions] Parameters] Heferences] Eonfigurations]

General

Marne: |BDSS{ Description,

Selection

Elements: Select... 1]

ok | Cancel | |

Relocate the Anchor Point so that the boss will locate easier when being inserted into other parts, then, to finish
the definition, add a Description.

* In the Define Smart Object (dialog) window, next to the Anchor point: click Select...

* Pick the point that's at the apex of the two angled lines of the boss to relocate the anchor there.
1

Define Smart Object

Propertiesl Dptions] Parameters] F!eferenc:es] Configurations]

General

Mame: |BDSS Description: 7

Selection

Elements: Select... 3
Anchar point: Select... I

Ok | Cancel | Apply |

*  Click the Description button and add a statement similar to: 50 mm thick boss for gear case periphery clamp-
ing bolts, then click OK.

¢ Click the OK button to finish the definition.

As this Smart Object has several pieces to it, including a profile, a Linear Protrusion and a Simple Hole, let's test
it out before we save it. The first thing we will do is to locate the boss on an existing part face, located at the
correct point on the face.

* Right click on the Smart Object named SObj Boss and select the Insert option (optionally, use Insert Smart
Object ).

* Click on the lip face twice that you want the boss to locate on. The first time you click on the face is to fulfill
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Smart Objects

the requirement for the profile and the second time is to fulfill the location requirement for the Simple Hole.
» Right click on the Point item in the Selection list, and choose to Reset its definition.

*  Click the location point for the boss.
= B nsert smart object (€] (W7 (1)

= Anchor
O Face
& Foint

Orientation Default

Direction Default «

The boss is now located correctly, but not oriented correctly for insertion. Time to access the rest of the Selec-
tion List to accomplish that.

* Set the Orientation to Default and Direction to Align Z.
* Next, click the Down arrow next to Select and pick the 2 Points method of alignment.

* Pick the two points as shown, picking from outside point to inside point so as to "aim" the Z direction for
alignment correctly.

* Rotate the X-axis and set the angle to 180.

Here the inputs values depend on the anchor point and orientation.
= 5 Insert Smart Okject | €] N7 (1)
= Anchor
@ Face
& Point

Orientation Default -

I=)- Direction Align Z -

= @ Select 2 points

¢ Click OK to end the insertion.

Time now to Save Smart Object.

* Click to Save Smart Object.
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Smart Objects

* Set the directory to MySmartObjects.
* For the Name, enter Boss, then click the Save button.

* Click on any of the geometry of the Boss to reference it for the Directory, and respond Yes to the query, Se-
lection OK?.

* Right click in the MySmartObjectsDirectory and select the Refresh option.

>

| >
A2 Te =] |EB Madel [€ 2D Frofile | L 3D Frofie]

NG gs) 1| Q

Boss Gearcase_zl.. lip_extusion  Many Holes Rect_Prof  Wwall_extrusion

Let's add this Boss feature around the periphery of a Slot shaped part.
» Either Delete all parts but for the Slot shaped or, if you do not have these parts, use your MySmartObjects
Directory components to make them.

*  Zoom Window on the Slot shaped part, focusing around a location you would like to use for the Boss
(Similar to the one shown in the picture).

» Drag/drop a Boss onto the lip face, close to where you want to place it, clicking the face once to locate the
profile and once again to locate the face for the hole.

Reposition and re-orient the Boss.

* Right click on the Selection entry, Point, select to Reset and pick the bottom point of the merge line between
the two side faces.

* Make the settings such a way that the orientation of the Boss should be as shown in the image file.

¢ Click OK to end the command.
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- B insert Smart object (3¢) W) (1)

= Anchor

Orientation Align X
S
@ Line
Do

Direction Default

About Z 0 deg

Create three additional Boss entries around the periphery of the gear case (Change the color of the solid to a
lighter color for better visualization if desired, using Color ).

* Change the Color of the part to a lighter color, if desired (recommended).

* Use Zoom Window to aid in placing the Bosses correctly.

* Position and Re-orient each one as we did in the last steps.

As we review the part, it becomes obvious that it could sure use another boss for a bolt that's located half way
around between the bosses we just added. There does not appear to be any good geometry available to snap the
boss' location to, so we shall use a slightly different method for positioning and orienting this boss we're adding.

* As you have done before, Drag/drop a Boss onto the lip face, clicking on the face twice to meet positioning
requirements.

* Right click the Point and choose to Reset it. This time, as there is no natural occurring point, use Mid Point
Snap and click on the edge that would ordinarily have contained the point, near the midpoint of the large ra-
dius end.
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- B Insert Smart Object | 3]

(=l Anchar

@ Face
@

Crientation Default -

Direction Defautt -

¢ Qrient it as shown.

¢ Click OK to end the command.

Well, we are certainly becoming proficient with defining and using Smart Objects. The next task is to put all the
pieces together to make a sophisticated Smart Object that will define a component interface for the gear cases.

5. Step 5: Creating Advanced Smart Objects

In the first four projects, we were working on various types of Smart Objects. The purpose of this lab is to put
all the pieces together to get a sense of ThinkDesign utility. We will design an advanced profile, based on mini-
mal input, that will, in turn, produce a fairly intricate structure, that has its own underlying components created
relative to it. The major steps are:

* Create the profile.

* Perform an operation with the profile.

* Add in other geometry that's designed to reference the profile.
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Smart Objects

* Contrast the various techniques of parameterizing the geometry.

» Save and test the Smart Object.

Before we get started, exit ThinkDesign and restart. This will achieve two purposes: 1) Give us a clean work
area; 2) Allow us to test our Smart Objects within a new ThinkDesign session, to verify that everything has been
saved correctly.

Now let's start defining the profile:

* Click on Insert > Profile > 2D to insert a Profile

* Create a Rectangle using the 2 Vertices option. Snap to Work Plane Origin for the lower left point, and at
an upper right point that will produce an X size of 240 X Size240 and a Y size of 140 Y Size140.
I+ [ Rectangle LXJ
5]

Mode 2 Vertices -

e e

Add in the geometry for an interior wall thickness of 5 mm.

* Click Parallel Line, setting the Type to Copy Length and the Sequence to Single.

* Offset the lines 5 mm from each side of the rectangle, on the interior side of the lines, and also aligned with
the original geometry. It is important that you actually type in the values for the offset in the minidialogs
(followed by "ENTER"), even though the system might show a snap to that amount directly, as the com-
mand works differently when you type in a value.

Note:

When you type in a value and you are currently in Profile Mode, you will get a parallel line exactly offset later-
ally the amount you specified from the reference geometry. Additionally the system will assign the value en-
tered as a Smart Dimension, thus helping you constrain the geometry as you go.
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Smart Objects

= /7 Parallel Line | 3]
@ Point
Type Copy length -
Sequence Single «
O Symmetric
[0 Half Plane

Distance S mm

Hit [Esclto end the command.

Clean up the interior of the walls and add 4 circles with centers at the four interior corners of the part.

* Click Smart Delete, and delete the eight line segments found in the interior of the walls at the four corners.

¢ Click Radius Circle with Mode set to Circle and Given Center set to Center. Add four circles at the four in-
terior corners and that each have a radius of 20. Radius20

5
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gl ———
Lef Ho L

We Ve Ve Ve

R0

T Hao

FED 5 Ho Ca
L

Smart Delete all interior lines bounded by the circles and Smart Delete the arc segment of the circles that sepa-
rate the circle from the wall interiors. We see as we do this, how the system adds/modifies constraints to keeps
things correctly related.

* Use Smart Delete to remove the interior line segments of the circles.

* Use Smart Delete to remove the arc segments between the inner and outer wall edges.

Hit[Esc)to end the command.
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Let's add both a horizontal, and vertical, outside Smart Dimension for the walls, then add a Ground Con-
straint at the center of the bottom left circle.

¢ Click Smart Dimension then add the Horizontal, and Vertical outside wall dimensions.

¢ Click Ground Constraint and add it to the center of the bottom left circle.
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Add Coincident Constraint conditions between the centers of the four corner circles and the inside wall geom-
etry in both X and Y.

¢ Add a Coincident Constraint for the Y Point between the center of the lower left circle and inner line of the
lower horizontal wall, then add a Y Point Coincident Constraint between the lower right circle center and
the inner line of the lower horizontal wall.

* Add a Coincident Constraint for the Y Point between the centers of the upper left circle and inner line of
the upper horizontal wall, then add a Y Point Coincident Constraint between the upper right circle center
and the inner line of the upper horizontal wall.

* Apply an X Point Coincident Constraint between the upper left circle's center and the inner line of the left
wall, then an X PointCoincident Constraint between that same line and the lower left circle's center point.

* Apply an X Point Coincident Constraint between the upper right circle's center and the inner line of the
right wall, then an X PointCoincident Constraint between that same line and the lower right circle's center
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Smart Objects

point.

Apply Automatic Constraint for the Profile, If any constraints are left out, ThinkDesign adds them automati-
cally.
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Let's verify our constraints.

* Click Check Profile.

* Review the values to insure that we have correctly constrained the geometry.

= €2 Check Profie | ]
Right Mumber of Constraints
Mo. of constraints: 44 (34 Logical, 10 Dimensional, 0 Dangling ext. ref.)
Ma. of entities: 1!3I _ 24“:]
=l More Options
Welldefined: :I 16 Ertities, 35 Snap pointz 1l

=] B

Uncerdefined: Nane B
LR T i
Overdefined: Mone
T

Mot Consistent: Mone
(N}

Time now to set Parameter names in place of the geometry values.

» Referencing the figure below, double click on each of the dimensions you want to assign a Parameter name
to.

* In the Expression box, enter the appropriate name as shown in the figure, below.

* Click on the Rebuild Model icon twice to implement.

* Repeat for all expressions shown.
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Let's add some relationships between the parameters.

* Select the Spreadsheet.
* Set the Sorting order to Alphabetic by clicking on Name.
* Type in the Expression entries as shown

» Click Update to recalculate any changes for the values (there should be none).

Spreadsheet

Tupe Mame | Uit | Expression | Value| Used|

1 |Standard Width Millimeters 240.00 240.00/0
2 Standard W/ allthk Millimeters 5.00 5.0000|0
3 Standard | ComPFlad Hillimeters 20.00 20.000/0
4 Standard  |Height Millimeters 140.00 140.00/0
5

<

™ Show independent variables only ™ Show automatic measure vanables
[ Deassign v|

*  Click the Rebuild button to exit the Spreadsheet.

Let's build a part now, that we can test our new profile on as we go through the process of defining a Smart Ob-
ject.

* Click to Switch to Model, finalizing our first profile definition.

* Create a Rectangle positioned in the work area similar to that shown, that's larger than our original profile,
We will use this second profile to build our reference solid.

* Click Linear Solid, using the default for the depth.
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- @@ Linear soiid (€] W) L1
@ Profie

[#- More Options

¢ Click OK to end the command.

Let's position the original profile on the face of the part we just made so that we can draw an extrusion out of it.

+ Click Edit®Work Plane™®Set on Faceand click on the top face of the part just created.

* Double click on the Work Plane icon and then select Move and reposition the Work Plane anywhere in the
lower left corner of the plate.

+ Click Modify®Profile®Move/Copy to Current Work Plane, click OK to the prompt for resetting the
Undo/Redo buffer and click on the profile to select it.

Use the profile to add a Sweep feature that's a Linear Protrusion.

* Click Linear Protrusion, and click on the profile geometry to select it.
* For the Depth, enter 70. Depth70

e In the Parameter Area, click the Fillet/Chamfer option, then click to Enable the capability and for the
../../Common edges, enter 5 for the radius of the fillet.
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(=38 iﬂLinear Pratrusion LXJ [i] [B
@ Profile

= Extension Depth O &nale

@ Face

= More Options

Direction Mormal
[

Tope: | Fillet -
Radiuz:  |Multipls 10 mm
TR

40 mm

T Comman

¢ Click OK to end the command.

Before we define our Smart Object, we need to add the four center holes that have a diameter of 20, at the four
circular corners of the extrude. They need to be through holes,through the underlying part. Let's make the first
one, NOw.

* Click Hole , and to meet the requirement for the Face in the Selection list, click on the top face of the extru-
sion just made, with the Diameter set to 20.

* As the point clicked for the face selection has also been used for the reference Hole location point, right
click on the Point entry and choose to Reset it.

* Snap to Arc Center , and click the Extension down arrow to verify the hole depth option is Thru All
=88 & Hale ij [!] [_!J
@ Face I, ,‘I

(= Type Point -

.
& Point b
O For screw
v
=+ Hale type: |Simple - a
d

Diatneter 20 mim

* Click Apply to add that hole.

Add the other three holes.

* Left click on the Point entry in the selection list to highlight it, then right click on it and choose Reset.
* Click to Snap to Arc Center, then click Apply to place the hole at that location.

* Repeat for the third of the four holes, and on the last hole, instead of using Apply, click OK to create the
hole and end the command.
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Let's use Define Smart Object to begin specifying information relative to the geometry and operations were go-
ing to capture.
* Click Define Smart Object, and for the Name, enter Box Enclosure.

*  Click the Description button, and type in:This is the Box Enclosure that's used in the gear case. To use, sim-
ply click on a point for its location, specify its orientation and size, and it will be added.

*  Click the OK button to end the Description.

Define Smart Object

Propertiesl Dptionsl Parametersl Heferencesl Eonfigurationsl

— General

M ame: IBox_encIosure Description; 7 |

— Selection

Elements: I Select... ID

ok Cancel | Apply |

Description

Thisg iz a Bow Enclosure thats uged in the gearcase. To
uze, gimply click on a point for its location, specify itz
orientation and size, and it will be added.

ok | Cancel I

Select the components to become part of your Smart Object definition.

* In the History Tree, right click on Linear Protrusion with Fillet and select Add.
* Right click on each of the Through hole entries and select to Add them to the definition.

Make changes to the Parameters table.

*  On the Define Smart Object (dialog) window, click the Parameters tab.

* For the first entry for WallThk, change the Message to Wall Thickness, the Name to WallThk1 and for its
Expression, replace Width*(1/48) with 5.

* Double check the Exposed checkbox for this first entry WallThk1 and do the check the Exposed option for
the Width variable so that they will both be modifiable. As you're on the Width variable line, change its mes-
sage to Box Width.
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Note:

When you change the Name for WallThk to WallThk1, notice that all related variables adapt to the new name,
as they are defined with interdependency in the spreadsheet we worked on earlier. Additionally, as you change
the Expression for WallThkl1, from a definition based to a value of 5, all the Value entries for WallThk1 update
to 5. Finally, as these variables are no longer Dependent on any other variable, you are now allowed to click the
Exposed checkbox to modify the value after the Smart Object has been used in design.

» 2]x]

Propertiez| Options F‘arametersl Fleferenc:es] Eonfigurations]

Message | Mame | Expression| Walue | Exposed| ~
8 Profile dimension | CormRad Width" (1112 20 mm |~
BowWidth 240mm |7

10 |Profile dimersion  |Height  ['/idth*(712/ 140 mm |~ hd
< ¥

r [~ Show only exposed

Ok, | Cancel | Apply |

Time now to provide Prompts for the user to guide them in using our Smart Object.

*  Click the References tab on the Define Smart Object (dialog) window.

» For the Message, type in: Select a location point for the lower left corner of the box.
b 2[x)

Properties] Dptions] Parameters Heferencesl Eonfigurations]

Meszage | Tupe ~
1 Select an anchor point [Prafile] | Absalute anchar

u for the lower left cormer of the box
v

< >

Ok | Cancel | Apply

Modify the Configuration, adding alternates.

*  Click the Configurations tab of the Define Smart Object (dialog) window.
* In the second line, for the Conf. name, enter Primary240/5, leaving the values shown.

e In the third line, for the Conf. name, enter Second250/7, changing the Wall Thickness to 7, and the Box
Width to 250.

Note:

The column header names are the Message Name values you entered in for the parameters. Also note that we re-
peated the default information, but used a different name. We cannot change the Default entries, but since the
access to them in our design environment references the configurations by their names, we give it a name that
best represents what we get if we select it.
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Define Smart Object

Properties] Dptions] Parameters] References Eonfigurations]

Piofle | Fiofle | Frofle | Bowwidh |
2 8 mm 5 mm 5 mm 240 mm
260 i
4 1 ™
< 4
Clear Conf. | Clear Table |

Ok, | Cancel | Apply |

Time to Save Smart Object the Smart Object with all these conditions just specified in the previous instruc-
tions.
*  On the Define Smart Object (dialog) window, click the Apply or OK button.

* Click the icon Save Smart Object, set the directory to MySmartObjects give it a name, Box_Enclosure, and
then hit the Save button.

*  Click on the geometry of the Smart Object, then affirm that the selection is OK, and to see it shown in the di-
rectory, Right click in the MySmartObjects directory and selecting Refresh.

¥
FIZTR]=] |o v

A& O @ gy

Boss Box_Enclos... Gearcase sl.. lip_estrusion  Many Holes

Last step is to drag/drop the Box Enclosure onto the other side of the plate, verifying that it works correctly
from the catalog.
* Rotate the plate so that the side without the enclosure is towards you.

* Left click on the Box_Enclosure and with the cursor down, drag the part over the plate, so that it is totally
bounded on all sides, then release the cursor to locate.

e Click OK to end the command.
6. Step 6: Applying Smart Objects

As we now have a fairly decent grounding in the creation and deployment of Smart Objects, it is now time to ap-
ply these objects with maximum effectiveness in the design of a gear case cover. We're going to:

» Select a profile, and create a wall that references it.

* Add the lip around the wall, and the boss supports for the bolts.
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¢ Add the cover and enclosure that mounts on it.

* Finally, create a Smart Object Family.

Drag/drop a Gearcase_slot_shape into the graphics area.

o Start with a new model.
» Ifitis not already, open the MySmartObjects directory by clicking Smart Object Library.

* Left click on the Gearcase slot shape and with the left button still pressed, drag the object over the graphics
area and release ("Drag/drop").

- B Insert Smart okject (3] (W) (1)

= Anchor
@ Poirt @\
& Face ’

Origntation Default -

Bosz Box_Enclos..

Blf

Rect_Prof  wall_Extrusio

Direction Default -
Showe parameters: Mone -

Configuration: Default -

*  Click OK to end the command.

Add the Wall extrusion and the Lip_extrusion onto the profile.

* Drag/drop the Wall_extrusion onto the profile (release the mouse over the profile Dimension to select all the
profile), then click OK.

* Drag/drop the Lip_extrusion onto the same profile, picking the face that contains the profile, and clicking
OK to finish the command.
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Add the bolt support bosses in (6) locations as shown.
» Drag/drop the Boss object onto the right end of the gear case and locate it in the correct position and with the
correct orientation, then click OK to end the placement at that location. Repeat for the left end.

* Drag/drop the Boss object into the the four corners formed between the lip and the four edges of transition
between the peripheral gear case walls, then click OK.

Note:

Locati ng the boss: Pick the lip face twice to select it for both the boss profile and the hole that has to pass
through both the boss and the lip.Posi ti oni ng t he boss: On the Selection list, right click on the Point en-
try, and Reset it. Snap to either the Midpoint for the boss location at one of the rounded ends, or to one of the (4)
Endpoint locations where the transition edges between wall segments intersect the lip, to redefine the
point.Ori enting the boss: Finally, click the down arrow next to the Selection list entry Orientation, and
choose the Align Y option. For the Select option, choose the 2 Points method, then reselect the same point de-
fined above and the center point of the adjacent gear case wall arc to orient the boss correctly towards it.

Create the 2D geometry that will be used to close the end of the gear case cover (opposite the lip end).

* Zoom Window on face that's to be flush with the cover outside face.
* Click Boundary Curve and select the All Boundaries option, then click on that face.

» Right click and select Apply.
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- I Boundary Curve LX] l)Z] l_!J

= Boundaries & -

@

O Associstive

O Insert Curve on Surface

[+ hore Options

«  Click (Estlto end the command.

Create a profile from the geometry just made.

+ Click Edit®>Work Plane™Set on Faceand pick the face just referenced for creating the 2D geometry from

the 3D edges. Right click on any of the interior boundary lines of the face that the Work Plane is sitting on
and select the option to Chain from This to specify the entire interior profile.

i [} Boundary Curve [xj M E_!J

=l Boundaries 4l

O Associstive
O Ingert Curve on Surface Cantinue
# Mare Options Reset Current Selection
B X cancel
W oK ]
llaooly x|
Select 4
= 4
Info L4
/ Cptions. ..
Customize
Help 3

* For the Depth, enter as Depth-7 to indicate the sweep is into the part from the top surface Linear
Protrusion.

iﬁLinear Protrusion LXJ l)i] L!J

& Profile

=) Extension Depth -

0 Face

I= More Options

Direction Mormal -
-—

e
[ FilletiChamfer

Depth 7 mm

O Thickness
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* click OK to end the command.

Drag/drop a Box_enclosure onto the top of the gear case, and reposition it relative to the Work Plane origin.

» Left click on the Box_enclosure in the Catalog directory, and with the left button still pressed, drag the com-
ponent into the graphics area.

* Release left mouse button to locate the component over the cover.

» Right click on the Selection list entry, Point, choose to Reset, and finally, pick the Work Plane Origin.
- Insert Smart Object |9 WA 1)

=1+ Anchar
@ Point
@ Face
Origntation Defauft -
Direction Defautt -

@ FeEe
’

Showy parameters: Mone
Ik Rl

Configuration: Default -

Add a secondary box that has a control dimension of 140, instead of 240, and located at a location of your
choosing on the cover.

» Drag/drop a second Box_enclosure onto the cover, making sure it entirely rests within the bounds of the
cover, then click OK.

* Double click on the dimension for this second box, and change the value to 140.

2%
Expreszion Waluz
v X8 || [140 mm

¢ Click Rebuild Model.
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As this Box_enclosure component has an exposed parameter associated with it, we might select to enter it as a
component into a Smart Object Family.

* In the History Tree, right click on one of the SObj Box_enclosure entries and select the option to Create
Smart Object Family

= % Model1
=B Solid (156}
E: @W

&1 50bj Expand all

£
[+ iﬁ Lin&r| g4 Roll Back Here

+ 20 50bj z

+- 8% 50 %"Redefine Feature

+ @V 50bj ?Delete Feature

+- 8% 50 Assign variable/Feature ;
+ 20 50bj »& Hide Driving Dimensions 3 :
#- G S0bj Rename

+ éﬁ Linear

+- 8% 50 Search

+ ’a Linear Search this Mame

Info 4

Insert

Save As
Break

The Part Family Properties menu will appear, in which we will make the following changes.

* For the Additional desc.:, enter Reinforced corner design.

* For the Part Description:, type in Electrical container weldment.

Enter/edit general part Family properties

Mame: ’W
Description: | This iz a Box Enclozune thats used int
Additional desc.: |Heinf0rced corner design
Future type: [COMPONENT
Part description: |Electlical containgr weldment
Car

* Click the OK button to continue, then wait a few seconds for the part to be recorded and click the Close but-
ton on the Warning message box that appears.

Verify that we have accessible information in our Catalog.

* ClickThinkteam > Thinkparts >Catalog Browser.
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*  Click to Expand the Smart Object Family.
x|

- Catalog
=l Smart Object Family
<& This is the Box Enclosure that's use

tr_unknown.brp

*  Open the entry that appears.

** thinkparts [Box_enclosure - This is the Box Enclosure t... |:||E|r>__<|

E{} Eﬁ @ E Wiew type: |F'alt Fannily j
Mame | Description | Wall Thick... | Biox Width |
k[ 5| 0
2’3 5 240
& 7 250
[~ Show codified partz only ok | Cloze |

We could now take pieces of this current part and group them into yet other Smart Object definitions. The possi-
bilities are endless. Congratulations on this job well done!!!

Rel at ed Topi cs

¢ Rules for Profiles and Constraints

* Defining Smart Objects
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